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Source for InDesign CS3: http://rufus.li/kfZXfu

CS3
Version 5.0 | April 2007

CS4
Version 6.0 | September 2008

CS5.5
Version 7.0 | April 2010
Version 7.5 | April 2011

Integration with Adobe Bridge CS4
Browse, organize, label, and preview graphics 
and InDesign documents, templates, and 
snippets in Adobe Bridge. Drag and drop 
assets from Bridge into layouts easily and 
efficiently. Search for files using metadata that 
specifies keywords, fonts, colors, and more.

InDesign Markup Language (IDML)
InDesign Markup Language, an XML- based 
file format, allows developers to assemble 
and disassemble InDesign documents using 
standard XML tools and without having to 
open INDD files.

Assignments improvements
New assignment operations in InCopy 
workflows are now enabled for unsaved 
InDesign documents.

Adobe Services
Adobe community help - Get help from the 
biggest talent pool out there, quickly, with 
targeted searches.
ConnectNow - Collaborate with clients, 
colleagues, and vendors by sharing your 
desktop so that you can quickly complete 
group reviews and show your work with ease.
Adobe kuler panel - Explore, create, and 
share colors using Adobe kuler, a web-hosted 
application for experimenting with color 
and sharing themes with the online kuler 
community.

Source for InDesign CS4: http://rufus.li/mfuvRh

FLV and MP3 import
You can now import video files in Flash Video 
format (.FLV and .F4V), H.264-encoded files 
(such as MP4), and SWF files. You can import 
audio files in MP3 format.

Media panel
The Media panel lets you preview SWF, FLV, 
F4V, MP4, and MP3 files directly in InDesign. 
For FLV, F4V, and MP4 files, you can choose 
any frame in the video as the placeholder 
poster image. You can choose which video 
playback controls you want the viewer of your 
interactive document to have.

Motion presets
The Animation panel lets you assign a motion 
preset to any page item as a way to quickly 
create an animation. These motion presets 
are the same motion presets found in Adobe 
Flash CS5 Professional.

Animation panel
Use the Animation panel to create or edit 
animation effects. You can edit supported 
animation attributes such as Position, Scale, 
Rotate, and Opacity.

Timing panel
Use the Timing panel to change the order of 
when animated objects play.

Object States panel
Use the Object States panel to create multiple 
versions of an object.

Preview panel
In InDesign, you can preview interactivity and 
animation of the current selection, the current 
spread, or the entire document using the 
Preview panel.

Pixels as unit of measurement
You can now also specify Pixels for your unit of 
measure.

Automatically convert URLs to 
hyperlinks
Use the Convert URLs To Hyperlinks command 
to search the current selection, story, or 
document for URL strings and convert them 
to hyperlinks.

Improved export to Flash Player
SWF file export can now include animation, 
video, audio, and remote rollovers. In addition, 
several new options let you control the final 
SWF file output.

Improved export to Flash Professional
InDesign CS5 exports to FLA format rather 
than XFL format for editing the file in Flash 
Professional. FLA export options support rich 
media content and offer more ways to handle 
text.

Improved export to Interactive PDF
InDesign CS5 includes separate commands for 
exporting print and interactive PDF files.

Improved XHTML export
Exporting to XHTML is a way to extract your 
content out of an InDesign document and 
hand it over to a web developer who can 
repurpose it using a web application such as 
Dreamweaver.

Improved JPEG export
The Export JPEG dialog box includes several 
new options, including the ability to specify 
the color space, use document bleed settings, 
and simulate overprinting.

Source for InDesign CS5 and CS5.5: http://rufus.li/mldf0X

Text variables
Automate the use of repeating elements such 
as headers, footers, product names, and date 
stamps. Running headers and footers can 
be generated from the text and dynamically 
updated as text flows from page to page.

Advanced bulleted and numbered lists
Create sophisticated lists with hierarchical, 
outline-style number sequences. Set styles, 
modes, alignment, indents, and other 
advanced options for different levels of 
bulleted and numbered lists. You can interrupt 
lists and spread them across different pages 
and stories.

More powerful Find/Change capabilities
Search and replace more efficiently with new 
find/change features. You can save searches, 
search across many documents, enlarge the 
scope of a search, and use GREP expressions 
in searches.

Convenient Glyphs panel
Use the Glyphs panel to locate recently used 
glyphs, filter and sort glyphs, and save glyph 
sets for sharing and reuse.

Nested style looping
Automatically apply a sequence of character 
styles within a paragraph with one click 
instead of manually formatting each style 
change. With nested style looping, you can 
repeat a sequence of nested styles until the 
end of a paragraph.

Table and cell styles
As well as applying styles to characters and 
paragraphs, apply styles to a table or to table 
cells. With table styles and cell styles, you 
no longer have to manually format tables or 
individual table cells.

Customized workspaces
Save your panel and menu changes as 
a workspace and be able to call up your 
personalized workspaces any time. You can 
create different workspaces for different 
projects and tasks.

Customized menus
Get direct access to commonly used 
commands or simplify training on new 
workflows by color-coding or hiding 
individual menu items. Save customized 
menus as part of a workspace.

Enhanced Control panel
Rely on the context-sensitive Control panel 
to show you the most useful settings based 
on the objects you selected and the type of 
work you are doing. You can also customize 
the Control panel to show only your most 
frequently used options.

Flexible compact panels
Make more room for viewing your document 
while preserving instant access to your 
favorite features. View docked panels as 
icons to keep them accessible and easily 
recognizable.

Agate measurement units
Take advantage of agate measurement units 
for newspaper publishing.

Visual Pages panel
Quickly navigate a document and arrange its 
pages using thumbnail previews in the Pages 
panel.

E-mail-based assignments for InCopy 
workflow
Use new e-mail-based assignments to send 
stories and graphics as a single assignment 
package to any contributor in your small 
workgroup via e-mail. The e-mail package 
contains all of the information needed to 
update the layout with the added or edited 
content, so it’s easy to assign tasks and 
integrate contributions without the need for a 
shared server.

Automatically generated layouts from 
XML
Automate the creation and formatting of 
documents by integrating InDesign content 
into XML workflows by way of XML rules. 
The conditional rules automatically adapt 
formatting and layout depending on content.

Support for XSLT and CALS tables with 
XML
Apply XSLT style sheets when importing or 
exporting XML content to make flowing XML 
into InDesign pages easier.

Export to XHTML
Quickly repurpose InDesign content for the 
web by exporting to XHTML. Styles can be 
mapped to an external CSS to instantly format 
your content.

Conditional text
Use conditional text deliver multiple versions 
of a document for different users and 
channels. Create conditions and apply them 
to text for audience customization.

All language user dictionary
Add a custom word, name, or phrase to a user 
dictionary and all languages treat the term as 
correctly spelled.

Smart Text Reflow
Treat InDesign as a word processor. Let 
InDesign add or remove pages automatically 
when you type text, hide conditions, or 
change or your text flow.

Autocorrect editing
Edit entries on your Autocorrect misspelling 
list without having to delete and add entries.

Table enhancements
Tables in the Story Editor display text in 
sequential columns and rows for easy editing. 
See Working with tables in Story Editor. Apply 
changes to cell and table borders without 
reselecting the stroke proxy borders.

Nested line styles
Use nested line styles to apply complex 
character formatting through the end of a 
line. Formatting remains unchanged when 
text is edited.

Style creation in context
In dialog boxes where you can select a 
character or paragraph style, you can create 
a style without having to exit the dialog box. 
This ability is especially useful when you’re 
generating a table of contents, creating 
nested styles or GREP styles, or using Find/
Change to change text formatting to a style.

GREP styles
Apply character styles to any text in a 
paragraph that matches the GREP expression 
you specify.

Better style group management
Move styles in or out of style groups when 
synchronizing a book without creating 
duplicate styles.

Text stroke control
Adjust stroke cap, end join, miter limit, and 
stroke alignment on text without having to 
convert characters to outlines. These stroke 
options are also available in styles.

Cross-references
Insert and edit cross-references. Choose 
among different formats, or create your own. 
Cross-references are easily updated when 
pagination changes.

Leading-based baseline grid increments
If you specify a different measurement system, 
such as millimeters or inches, baseline grid 
values still use points to match text size and 
leading.

Page transitions in PDF and SWF files
Apply page transitions directly in InDesign 
to individual pages or all spreads at once 
with a single click. See previews of available 
transition types, and control the direction and 
speed of your transitions for output to SWF 
and PDF files.

Enhanced buttons
Build interactive buttons using the updated 
Button panel. Design custom buttons or select 
a button from the integrated button library. 
Create buttons that let you navigate within a 
dynamic document, launch a movie, or play a 
sound.

Redesigned Hyperlinks panel
Use the redesigned Hyperlinks panel to 
easily create hyperlinks that navigate to 
external URLs, link to files with supplemental 
information, launch an e-mail client, or jump 
to a page or section of a page within the same 
or even a different document. Verify your 
hyperlinks directly in InDesign CS4 with no 
need to export the document to a PDF or SWF 
file for testing.

Export to Flash (SWF)
Export SWF files directly from within InDesign, 
complete with page transitions, interactive 
buttons, rollovers, and hyperlinks.

Export to Flash (XFL)
Export your InDesign document in the new 
XFL file format for opening in Adobe Flash® 
CS4 Professional. Use the Flash authoring 
environment to add video, audio, animation, 
and complex interactivity.

Interactive PDF enhancements
Author interactive PDF documents by adding 
SWF files, Quicktime movies, and sound 
clips to your page layouts. Create interactive 
buttons, apply page transitions, and embed 
hyperlinks, cross-references, and bookmarks 
to create an immersive reading experience.

Creative effects
Experiment with designs right on the 
page layout with Adobe Photoshop®-like 
effects. You can experiment with blending 
modes, opacity, and other effects without 
permanently altering your objects. And you 
can save effects as part of an object style for 
easy reuse and sharing.
Gradient feather - Fade an object into the 
background by way of an adjustable linear or 
radial gradient.
Directional feather - Enhance feathering 
by customizing the feather angle and the 
amount of feathering on each side.
Bevel and Emboss - Add inner highlights and 
shadows that create a relief effect.
Satin - Apply interior shading that creates a 
satin-like finish.
Inner Shadow - Add a shadow that falls just 
inside the edges of the object’s content, 
giving the object a recessed appearance.
Inner Glow and Outer Glow - Add glows that 
emanate from the inside and outside edges of 
an object.

Finer transparency controls
Create complex visual effects by applying 
multiple transparency settings to a single 
object. You can apply transparency settings 
independently to an object’s fill, stroke, and 
content.

Multi-file placing
Import several different files in one step. You 
can see thumbnail views of the different files 
and cycle through them until you find the one 
you want to place.

Placed InDesign documents
Shorten the layout process and collaborate 
more effectively by reusing Adobe InDesign® 
CS3 documents. When InDesign files are 
placed in the document, the Links panel 
provides notification of updates, eliminating 
the need to save and manage interim files.

Improved text wrap
Easily flow text around objects. Wrap to a 
side or according to a clipping path or alpha 
channel.

Fast frame-fitting
Set the default fit behavior of frames and 
assign fit options to object styles so that, as 
soon as you place a graphic or other content 
in a frame, it fits perfectly.

Expanded Quick Apply
Type a few letters into the Quick Apply 
panel and be able to access commands, text 
variables, scripts, and styles instantly without 
having to rummage around in different 
panels. You can also customize Quick Apply 
searches.

Edit Original flexibility
Use the Edit With command to choose which 
application to use to edit a placed item 
instead of relying on the operating system to 
default to the appropriate program.

Constrained placement of graphics
A frame drawn while an image is in the loaded 
cursor constrains to the proportions of the 
graphic. The graphic then fits to the frame 
proportionally and is centered unless frame 
fitting options have been applied to the 
frame. 

Placing multiple graphics as a contact 
sheet
Quickly create a contact sheet by placing 
multiple images in a grid arrangement.

Multiple artboard placement
Cycle through multiple artboards created in 
Adobe Illustrator® CS4 for quick placement in 
your InDesign document.

New Pathfinder panel buttons
Use one step to join paths, open paths, or 
reverse paths by clicking a button in the new 
Paths row in the Pathfinder panel.

Convert Point menu commands
Convert corner points to smooth or line end 
points using the Convert Point commands 
that are now accessible through the menus.

Free Transform tool improvements
Resize an object more easily using the Free 
Transform tool, thanks to larger hit zones 
around object handles and the ability to resize 
along object edges.

Keyboard shortcuts for scaling and sizing
Use new options in the keyboard shortcut 
editor to easily create shortcuts for increasing 
and decreasing size. Separate keyboard 
shortcuts are included for scaling and sizing 
objects.

Live preflight
Preflight while you design for better results, 
greater time savings, and lower production 
costs. Continuous preflighting alerts you to 
potential production problems in real time. 
The new Preflight panel lets you navigate to 
and select the objects that are triggering the 
preflight error. View contextual tips to help 
you correct errors directly in layout.

Spread view rotation
Temporarily rotate the spread view without 
physically turning your monitor. Enjoy full 
editing capability at 90 and 180 degree angles 
so that you can work on non-horizontal 
design elements, such as rotated calendar 
spreads and tables.

Smart Guides
Align, space, rotate, and resize multiple 
objects in one step. Align to the horizontal, 
vertical, or center of page edges. The 
guides, object dimensions, rotation, and X,Y 
coordinates appear dynamically so you can 
snap objects in relation to other objects in the 
layout.
Smart Dimensions  - When you create, resize, 
or rotate one object, Smart Dimensions shows 
the width, height, or rotation of your object, 
highlighting when the dimensions or rotation 
matches nearby objects.
Smart Spacing  - Evenly space multiple 
items on your page by snapping objects into 
position without having to use the Align 
panel.
Smart Cursors - When transforming objects, the 
cursor displays X and Y position, width and height, 
or rotation information. The Show Transformation 
Values option in Interface preferences lets you turn 
smart cursors on and off.

Versatile Links panel
Find, sort, and organize placed content 
with the redesigned Links panel. Scan link 
attributes and click to view details such as 
scale, rotation, and resolution. Customize the 
Links panel to suit your working preferences. 
Quickly replace low-resolution images used 
as placeholders with high-resolution images 
based on filename. Filename extensions are 
ignored. Simply relink to a new folder.

New pages sizes
New common monitor resolution sizes are 
available in the Page Size menu in the New 
Document dialog box. These options make 
it easier to design a document to a specific 
monitor size for interactive SWF, XFL, and PDF 
workflows.

Quick guide deletion
Instantly clear all selectable guides on your 
current spread or master page by right-
clicking (Windows) or Ctrl-clicking (Mac OS) a 
ruler and choosing Delete All Guides.

Data merge output to PDF
Run a data merge operation and output 
directly to PDF in a single pass, thanks to the 
Export to PDF command now included in the 
Data Merge panel. An intermediate InDesign 
document is no longer created.

Ruler origin on spine
Correctly place the ruler’s zero position of X 
at the spine of your document so that the X 
values are positive for right sided pages and 
negative for left sided pages when Facing 
Pages is enabled.

Slug area enhancements
Move pages and see that your objects in the 
slug and bleed area also move. Page numbers 
in the slug area display a number rather than 
the pasteboard index entry (PB).

Undo improvements
Viewing actions such as Set Preview and Show 
Guides are no longer included as Undo items.

Integrated comment and review
CS Review is an online service that provides 
a simple way to share designs on the web so 
others can provide feedback.

Mini Bridge
Mini Bridge is a subset of Adobe Bridge that 
is available as a panel within InDesign. Mini 
Bridge lets you navigate your file system and 
preview files as visual thumbnails without 
having to leave InDesign.

Improved Adobe Bridge integration
InDesign CS5 and Adobe Bridge CS5 are more 
integrated in two ways.

Multiple page sizes
You can define different page sizes for pages 
within a single document. This feature is 
especially useful when you want to manage 
related designs in one file. For example, 
you can include business card, postcard, 
letterhead, and envelope pages in the same 
document.

New Layers panel
The Layers panel is now more similar to the 
Illustrator Layers panel. Each layer has a 
disclosure triangle that can be expanded to 
reveal the objects and their stacking order on 
that given layer for the active spread.

Custom page sizes
Instead of editing a text file to create custom 
page sizes, you can use the Custom Page 
Size dialog box to make custom page sizes 
available when you create documents.

Simplified transformations
InDesign includes several new selection 
and transformation features that simplify 
manipulating objects.

Content grabber
The content grabber appears as a circle when 
you hover over an image using the Selection 
tool. This behavior effectively replaces that 
of the Position tool, which is removed from 
InDesign CS5.

Double-click behavior
Double-clicking a graphic frame now selects 
the content in the frame. In a group, double-
clicking an item in the group selects the item 
you double-clicked. This approach gives you 
a quick and consistent way to select graphic 
frames and groups.

Frame edge highlighting
InDesign now temporarily draws the frame 
edges as you use the Selection tool to 
hover over items on a page. This feedback is 
especially helpful when working in Preview 
Mode or with Hide Frame Edges selected.

Path and point highlighting
When you hover over a page item with the 
Direct Selection tool, InDesign displays 
the path and display the path points. This 
feedback makes it easier to view the path 
point you want to manipulate.

Rotate
As in Illustrator, you don’t have to switch 
to the Rotate tool to rotate a selected page 
item. With the Selection tool, you can simply 
position the pointer just outside a corner 
handle, and drag to rotate the item.

Transform multiple selected items
You no longer have to group multiple items 
before you can resize, scale, or rotate them 
with the Selection tool. Simply select the 
items you want to transform, and you see a 
transformation bounding box around the 
selected items.

Live Screen Drawing
In InDesign CS5, you see the content draw 
as you drag it. In previous InDesign versions, 
you pause before dragging to see the content 
draw.

Favor the selected object
If you select one of several overlapping page 
items and begin dragging, the selected object 
remains selected. To select a different item, 
simply click a portion of that different item 
that is not overlapping or intersecting the 
currently selected item.

Live Distribute
When transforming multiple selected objects, 
InDesign CS5 lets you proportionally resize 
the space between the selected items instead 
of resizing the actual items.

Reordering of the Transformation Tools
The Rotate, Scale, and Shear tools appear 
under the Free Transform tool in the Tools 
panel. You can rotate, resize, and scale objects 
without having to switch from the Selection 
tool.

Gap tool
The Gap tool provides a quick way to adjust 
the size of a gap between two or more items. 
The Gap tool is a one-step way to adjust 
your layout by directly manipulating the 
whitespace.

Live corner effects
Click the yellow square that appears near 
the upper right corner of a selected frame to 
apply corner effects to rectangular frames. In 
addition, you can now apply a different corner 
effect and a different corner radius to each 
corner.

Swatches in Control panel
You can apply swatches to objects directly in 
the Control panel. Select an object and choose 
the swatch from the Fill or Stroke menu in the 
Control panel. You can also drag the current 
color swatch displayed in the Control panel 
and apply it to other objects.

Grid place enhancements
When placing multiple files, simply start 
dragging, and then use the arrow keys to 
change the number of columns and rows of 
the placed images.

Auto-Fit
Select the Auto-Fit option so that the image is 
resized automatically whenever you resize the 
frame.

Drawing multiple frames in a grid
When using frame creation tools such as the 
Rectangle or Type tool, you can press arrow 
keys to create equally spaced frames.

Duplicating objects into a grid
You can create a grid of objects while 
dragging a copy of a selected object.

Live captions from metadata
In InDesign CS5, you can generate captions 
based on image metadata using a number of 
methods.

Specify starting page number
When you create a document in InDesign 
CS5, you can make the first page start on a 
specified page number.

Edit Original for multiple selected items
You can choose the Edit Original command 
to open multiple images in their respective 
editing applications.

New options for locking objects
To lock and unlock objects, you can now 
choose Object > Lock or Object > Unlock All 
On Spread. Clicking the lock icon also unlocks 
a locked object.

Relink file extensions
Relink files based on file extension. For 
example, you can replace a set of JPEG files 
with TIFF files.

Hide objects
You can now choose Object > Hide to hide 
objects on the page. Hidden objects are not 
printed or exported, and they cannot be 
selected.

Place cursor when dragging from Adobe 
Bridge
In previous versions, dragging an image from 
Adobe Bridge or the desktop inserted the 
image on to the page, creating a frame the 
size of the image. In InDesign CS5, this action 
loads the place cursor, letting you drag a 
proportionally sized frame for your image.

Round CMYK values to whole numbers
The Colors panel round the values for the 
CMYK sliders to the nearest whole value.

Delete all guides
There is now a new Delete All Guides On 
Spread.

Fold marks
If you select Crop Marks while printing 
spreads, fold marks are printed as solid lines.

So you think Adobe InDesign 
has become all about 
interactive Schnickschnack?
Think again.

Paragraphs that span or split columns
In InDesign CS5, you can make a paragraph 
span multiple columns without creating 
separate text frames. You can also split a 
paragraph into multiple columns within the 
same text frame.

Keep with previous
The Keep Options dialog box now has a Keep 
With Previous option that keeps the first line 
of the current paragraph with the last line of 
the previous paragraph.

Balanced columns
The Balance Columns setting in the Text Frame 
Options dialog box lets you automatically 
balance text across columns in a multiple 
column text frame.

Vertical justification in non-rectangular 
frames
In previous versions of InDesign, applying a 
non-rectangular text frame causes vertical 
justification settings to be ignored. In 
InDesign CS5, you can apply both vertical 
justification and corner effects and other 
irregular-shaped frames.

New default font
The default font is changed from Times (Mac) 
and Times New Roman (Windows) to the 
cross-platform OpenType version of Minion 
Pro Regular.

Remember Story Editor window location
When you close and reopen a Story Editor 
window, InDesign reopens the window to its 
previous width, height, and location on the 
screen.

Track text changes
When the Track Text Changes feature is turned 
on, changes made to the text are tracked on a 
per user basis. Use the Track Changes panel to 
accept and reject changes in the document.

Document installed fonts
Any fonts in a Document Fonts folder that’s in 
the same location as an InDesign document 
are available when the document is opened. 

Buzzword integration
Buzzword is a web-based text editor that 
lets users create and store text files on a web 
server. In InDesign CS5, you can import and 
export text from Buzzword documents.

Zoom from dialog boxes
You can now use the keyboard shortcuts to 
zoom in and out of your document when you 
have a modal dialog box open.

Collapse multiple links to same source
In InDesign, links to images placed multiple 
times in a document are collapsed into a 
single row in the Links panel. You can now 
turn off this collapsing behavior with a new 
option in the Panel Options dialog box.

Page Thumbnails
A new File Handling preference option lets 
you generate page thumbnails for more than 
the first page of InDesign files.

Background tasks
When you save large documents or export 
them to PDF or IDML files, you can continue 
working on your document.

Spring-loaded tools shortcut
You can temporarily switch from the current 
tool to any other tool by holding down the 
appropriate letter key.

Tool Hints panel
The Tool Hints panel lists all the hidden 
modifier key behaviors available for the 
currently selected tool.

Sticky Preview check boxes
InDesign now remembers whether the 
Preview checkbox is selected in a dialog box 
after you exit and restart.

Open book files in Explorer or Finder
A command appears on the books panel 
menu that lets you view a document in an 
Explorer or Finder window.

View Links in an InDesign File while in 
Bridge
You can view the links inside an InDesign 
document while in Adobe Bridge, without 
having to open the document in InDesign. For 
example, suppose that you don’t remember 
the location of an image, but you remember 
placing it in an InDesign document. In Adobe 
Bridge, navigate to the InDesign file, and 
then display thumbnails of all the placed files 
contained within the selected InDesign file.

Presentation Mode
InDesign CS5 has a new screen mode called 
Presentation Mode. In Presentation Mode, the 
application menu and all panels are hidden.

Color labels for page thumbnails
You can now assign colored labels to the page 
thumbnails in the Pages panel.

Customized workspace enhancements
Select a task-based workspace that unclutters 
your screen and presents only the menu 
commands and panel arrangements best for 
the current task. Customize your own menus 
and workspaces that can be shared and saved.

Tabbed documents
Manage and work across multiple documents 
by tabbing through open documents to find 
the one you need without having to maximize 
each document individually.

N-up view
Arrange viewing multiple documents in 
a single window so that you can compare 
content and drag objects across documents. 
Use a button to switch your views side by side, 
top and bottom, or however you want.

Application frame (Mac OS)
For Mac OS users, you have the option to 
work with documents and panels in a single 
window. Move or resize the window without 
losing access to panels or other opened 
documents.

Application bar
Use a new control buttons in the menu bar to 
switch to a new workspace, modify the view 
of a document, perform a search, or quickly 
access elements such as Adobe Bridge CS4.

Reactive panels
Drag related content from one panel to 
another without first opening the receiving 
panel. For example, drag a swatch from the 
Swatch panel into the Color panel without 
opening it first.

More nudge buttons
Use the up and down arrows to nudge values 
for paragraph and character styles, find/
change formats, object styles, object corner 
options, and more.

Dialog box positioning
Dialog boxes open in the same screen location 
in which they were closed.

Command bar removed
The Command bar (also called PageMaker 
Toolbar) that appears in InDesign CS3 is no 
longer available in InDesign CS4.

Mouse scroll wheel support
Navigate through document pages using the 
mouse scroll wheel. The longer you hold the 
mouse at the top or bottom of the application 
window, the faster the pages scroll.

Power zoom
Use the Hand tool to zoom out by holding 
down your mouse button. Continue to hold, 
and you can move the zoom area marquee 
across pages. Release, and the view returns to 
your original zoom level in your new location. 
Increase or decrease the size of the zoom area 
marquee using the up and down arrows or 
scroll wheel on the mouse.

Visual Pages panel
See thumbnails of your pages in the 
Pages panel for easy navigation and page 
arrangement. If transparency, page transitions, 
or spread rotation have been applied to 
pages, you can turn off their associated icons 
for a cleaner Pages panel.
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Many times have I heard users asking me “so what are the new features in InDesign?” or telling me “there is nothing in the new versions 
that would benefit my workflow”. Really!? To make this list, I went to Adobe.com and copied the “what’s new” section for each of the above 
mentioned versions of Adobe InDesign. I then reordered the new features by areas of interest (which do not necessarily reflect those 
chosen by Adobe), and here are the surprising results.� Rufus Deuchler, May 2011 - Version 2 (rufus.deuchler.net)

A visual representation of new features introduced 
since InDesign CS3 based on lists available in the 
help file for each version at Adobe.com.

Improved EPUB and HTML export
InDesign CS5.5 contains a re-engineered EPUB 
and HTML export solution that offers several 
improvements to the EPUB export workflow.
General export options - Define book 
margins, use article order to specify reading 
order.
Image export options - Define image 
resolution PPI settings, size, and added 
support for PNG images. You can also specify 
image alignment settings, space before and 
after images, and insert page breaks. 
Content export options - Break document by 
paragraph styles, enhancements to footnotes, 
remove soft returns.
Audio and video tags in HTML - Placed audio 
and h.264 video files are enclosed in HTML5 
<audio> and <video> tags. An increasing 
numbers of hardware and software vendors 
now support HTML5 audio and video tags.
J-language features - Support for vertical 
text and Ruby characters.
Added support for sublists - Sublists 
formatted using the InDesign auto-bullet 
and auto-number features are represented as 
nested ordered and unordered lists.
Table headers and footers - Table headers 
and footers are exported to EPUB and HTML.
Table of contents - InDesign table of content 
is now included in the EPUB export instead of 
the NCX manifest.
Publish date - Publish date metadata value 
is automatically inserted. Other data such as 
author and keywords, that you provide using 
the File > File Info are also exported to the 
EPUB file.

Articles
Articles provide an easy way to create 
relationships among page items. These 
relationships are used to define the content to 
export to EPUB, HTML, or Accessible PDFs; and 
to define the order of the content.

Object export options
Object export options are used to specify 
export parameters required when you export 
to different formats such as EPUB, HTML, 
or accessible PDFs. Object export options 
are applied to both text frames and graphic 
frames, as well as groups. Object export 
options are specified to individual objects or 
groups and can override the global export 
settings.

Map styles to export tags
The Paragraph and Character styles have a 
new subfeature—Export Tagging. Export 
Tagging lets you define how text with 
InDesign styles should be marked up in HTML/
EPUB or in the tagged PDF output.

Integration with Adobe Digital 
Publishing Suite
To create richly designed, interactive 
publications for tablet devices, InDesign 
includes Folio Builder and Overlay Creator 
panels. You can use these panels to create 
digital publications called folios.

Linked stories
Adobe InDesign CS5.5 linked stories makes 
it easier to manage multiple versions of 
the same story or text content in the same 
document.

Dictionary enhancements
InDesign supports the open-source HunSpell 
dictionaries for most languages to verify 
spelling and to hyphenate words, in addition 
to the existing Proximity and WinSoft 
dictionaries.

Drag and drop anchored objects
You can now drag an existing object into a 
text frame to anchor it. Drag the blue square 
near the top right corner to the location you 
want to anchor it to.

Better PDF tag support
Create accessible PDFs for Adobe Acrobat, 
Adobe Reader, or other software such as 
screen readers. InDesign automatically adds 
tags for the following: Tables and nested 
tables - Lists and nested lists - Footnotes
Hyperlinks.

Updated

CS5.5
features

PDF Enhancements
Support for PDF/X-4:2010 has been added. 
PDF/X-4:2010 is identical to the earlier 
PDF/X-4:2008, except that it relaxes certain 
restrictions on how layers can be specified in 
the PDF. This change allows InDesign CS5.5 to 
allow creating layers in the exported PDF, and 
provides PDF 1.6 compatibility. Apart from 
layers support, PDF 1.6 also allows JPEG2000 
compression as an option for the color and 
grayscale images.


